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From reading the comments about the June 2006
TUX announcement on our Web site, it seems there
is some confusion about what it takes to “install
software”. So, this month, I take a break from my
rambling and offer some down-to-earth information.

First, unlike other popular operating systems
including Microsoft Windows and Apple OS X, you
have a lot of choices. Think of Linux like you would
the expression “Japanese car”. Toyota and Mitsubishi
are brands of Japanese cars, and they share some
things but not everything. You might have a
Mitsubishi dealer in your town but not a Toyota dealer,
for example. But, they both use the same tires,
metric nuts and bolts and lots of other things.

If Linux is like a Japanese car, Microsoft Windows
might be more like a Ford. There are models of
Fords, but each one is made by the same company.
And although other people might make parts for a
Ford, the official parts come only from one source.

Back to Linux. When you get a copy of Linux,
some software is included in addition to the operat-
ing system itself. Generally, this will include hundreds
if not thousands of applications programs. It’s like
getting your car with a large box of clip-on acces-
sories. It is very easy for you to install and use them.

But, just like with your car, there are lots of
other accessories available as well. How to get those
accessories—that is, additional programs—varies
depending on the program and the version of Linux
you are running.

Now, I am going to try to convince you that these
“Linux accessories” are easier and faster to get up
and running than the equivalent accessories for
other operating systems. Yes, I said easier, but it
requires looking at the total process.

The first step is to locate what program you
might want. That part is likely to be equal to the
process for other operating systems. That is, you will
have some choices and might need to read some
reviews. Let’s assume you are now ready to get your
new program and install it.

The two most common methods to get applica-
tions programs for Microsoft Windows is either to
go to a computer store or order on-line. The most
common way to get applications programs for Linux
is to tell the package manager program—a program
you already have on your system—to download and
install the new software. This is a big win for Linux.
That isn’t always the answer, but it commonly is.

With a few exceptions, we can divide your choices
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into three lists:

1. Software available for easy install for
RPM-based systems. (RPM is short for
Red Hat Package Manager.)

2. Software available for easy install for
DEB-based systems. (DEB is short for
Debian package, basically used in all
Debian Linux-based distributions, such
as Debian, Ubuntu and Linspire.)

3. Software that must be built from the
source code.

If either number 1 or 2 is available,
you’ve got that “just tell the package
manager” feature to save you a lot of time.

With much software, all three versions
will be available, but for others, only one
or two options exist. In addition, much
like a tachometer for a Ford with a gaso-
line engine will probably not work on a
Ford with a diesel engine, there will be
cases where software will work only on a
particular version or versions of your sys-
tem. But, it is the job of the package
manager to figure all this out for you.

Hopefully, I haven’t totally confused
you here. Let me get a bit more specific
and see if I can keep you awake.

The Kubuntu distribution is one that
uses DEB packages. If a DEB package is
available for the software you want to

install, you will likely be able to install it
simply by starting up the adept package
manager, entering the name of the pack-
age in the search box (or searching for it
but that is fairly hard as there are more
than 18,000 packages available), and two
clicks later it is installed.

A more difficult but not very compli-
cated possibility is that you will need to
download the package, generally by
right-clicking on the file in your Web
browser and selecting where to save it.
Then, you start the dpkg command,
pointing it at the software.

The first approach is likely to work with
more than 90% of the software a TUX
reader will want to install and the second
with much of the remaining software. I
could stop here, but I want you to under-
stand what the third option is. You may
never use it, but appreciating what it is will
lower your stress level. This is using software
that must be built from the source code.

All this means is you need to download
the program source code and run some
development software to build a version of
the program for your system. This doesn’t
mean you need to know how to program
or anything about programming.

The source code for a program will
include a file usually called configure. This
is a program that analyzes what features
and software are available on your system
and then builds another file called Makefile.

The Makefile contains instructions for 
a program named make, which actually
builds the software.

The usual sequence of events to convert
source code to an installed new application
on Kubuntu would look something like
this (in shell commands you enter in a
terminal window):

cd wherever_you_put_the_source
./configure
make
sudo make install

That’s pretty much the worst case for
installing new software, and for a TUX
reader, it is likely you will need to do this
1% of the time or less. So, bottom line,
don’t panic. A default install of Linux on
your system will give you more immedi-
ately usable software than on any other
type of system, and you will be able to
add thousands of additional programs
with no more to do than selecting them
from a list of choices.

For that other 1%, you probably can
get away with offering someone a bever-
age or even a meal to do the hard work
for you. And, remember, you have more
than 18,000 programs to play with before
you have to give this more difficult
approach a try.�

Phil Hughes is Group Publisher for SSC Media Corp.
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FROM THE EDITOR IN CHIEF

Slogging through the Murky Swamp 
of the Digital Millennium Copyright Act

A few issues ago, a reader named Mark wrote TUX to express
his concerns about running Ubuntu Linux and the Digital
Millennium Copyright Act (DMCA) legal ramifications of using
using Automatix. I briefly answered his letter, basically
promising to cover this subject in more depth. When I started
planning this Linux Media Center issue, I thought it was a
perfect fit to include my research in the issue. Before diving
into this topic, however, I need to remind everyone that I am
not a lawyer, and the opinions that you are about to read are
not legal advice. I’ll share with you the same advice I got
from Phil Hughes, our Publisher, when I asked him about this
subject: “If you want to get help on this issue, please seek
the advice of a copyright attorney.”

Our first stop on this adventure starts with Mark’s situation.
He wrote in to share that he had installed Ubuntu Linux only
to find that it didn’t play DVDs or other video files. While
researching a solution, he found Automatix, but he also
discovered that installing it within the United States would be
in violation of the DMCA. After further research, he couldn’t
find a definitive answer concerning the legality of this soft-
ware, so he decided to remove Ubuntu and ask TUX for help.
As I mentioned before, I offer my analysis of this issue here,

but it is not legal advice. To complete my analysis, I first
examine the DMCA, then briefly introduce Automatix, and
finally, I clear up the confusion about this issue.

DIGITAL MILLENNIUM COPYRIGHT ACT
On our second stop, we enter the murkiness that is United
States copyright law. We’re stopping here to try to understand
the DMCA and blaze a path for our research—which is, from
what I can tell, one of the problems. If you’ve ever read any US
laws before, you’ll find them prepared for lawyers, by lawyers.
This bill is perhaps more difficult to understand than some others
because of the seemingly intentional ambiguity of the law. The
Unintended Consequences: Seven Years under the DMCA
document available from the Electronic Frontier Foundation
has as a good introduction to the law:

Congress enacted the DMCA’s anti-circumvention provi-
sions in response to two pressures. First, Congress was
responding to the perceived need to implement obliga-
tions imposed on the US by the 1996 World Intellectual
Property Organization (WIPO) Copyright Treaty. Section
1201, however, went further than the WIPO treaty

As an introduction to our Linux Media issue, I examine the legal ramifications of using Automatix to add proprietary codecs.

KEVIN SHOCKEY
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required. The details of section 1201, then, were a
response not just to US treaty obligations, but also to the
concerns of copyright owners that their works would be
widely pirated in the networked digital world.

Section 1201 contains two distinct prohibitions: a ban on
acts of circumvention and a ban on the distribution of tools and
technologies used for circumvention. In our particular case, it is
the second of these prohibitions that presents a potential prob-
lem. Continuing quoting from the EFF document:

The “tools” prohibitions, set out in sections 1201(a)(2) and
1201(b), outlaw the manufacture, sale, distribution, or
trafficking of tools and technologies that make circum-
vention possible. These provisions ban both technologies
that defeat access controls, and also technologies that
defeat use restrictions imposed by copyright owners, such
as copy controls. These provisions prohibit the distribution
of “DVD back-up” software, for example.

And finally, quoting from the EFF document: “A violation
of any of the ’act’ or ’tools’ prohibitions is subject to significant
civil and, in some circumstances, criminal penalties.”

AUTOMATIX
Our third stop further into this dark mess is Automatix.
Automatix (http://www.getautomatix.com) is a script that auto-
matically installs a laundry list of applications, plugins and utili-
ties. As this laundry list implies, there is actually a long list of
software that Automatix will install. Everything included in this
list is totally legitimate, with most of it being free or open-
source software. However, one set of the software is actually
codecs that will allow multimedia software to access and play

files encoded with a proprietary format. These codecs have been
created within the global software development community to
replace the actual codecs.

So what’s the problem? The problem is that these open-source
codecs were written to circumvent the process of actually
licensing the algorithms they duplicate. As described above,
the DMCA law was created to prohibit circumventing basically
anything that protects copyrighted material. Contrary to popular
opinion, software is not patented, it is copyrighted (business
processes are patentable, which is what some software includes—
a patented business process for completing a business function).
So according to the provisions of the DMCA, Automatix
potentially facilitates the circumvention of proprietary codecs.
Obviously, the codecs themselves might also be seen as 
circumventing the DMCA laws.

CONCLUSION
In our final stop, I raise a torch in the blackness and show read-
ers the options. It should be clear that Automatix, per se, is not
the issue. It is using Automatix to install proprietary codecs. So

P2P
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WHAT IS A CODEC ANYWAY?

A codec is a compression algorithm, used to reduce the 
size of a file or stream. There are audio codecs and video
codecs—examples include MPEG-1, MPEG-2, MPEG-3,
MPEG-4, Vorbis and DivX. Codec literally stands for encode
decode algorithms. A content producer will use one of the
proprietary algorithms to encode a file. In order for us to
view or hear a file, we have to use a decoder that will
decompress the file into a usable format.

http://www.getautomatix.com
http://www.tuxmagazine.com


the question becomes, how do Linux users gain access to the
codecs necessary to enjoy the audio and video files they desire?
Unfortunately, there are not very many options. Because it is rel-
atively easy to download and install these open-source codecs
through many means, you may choose to do so; however, you
do so at your own risk. If this risk worries you, make sure you
obtain legal advice before you do.

So there are really only two options. The first is the same one
Mark chose, go without. However, Mark took it too far and
erased Ubuntu. That was certainly not necessary if he did not
install Automatix. Unfortunately, this is one of the main reasons
many people keep a Windows box around: to play their audio
and video files. Fortunately, there is another option. For those
that want the added convenience of playing all popular formats,
you can purchase a copy of Linspire, Mandriva or Xandros.
However, of these three, Linspire offers the most complete set
of proprietary codecs. It does not package them all, but the
ones it does not ship with the software are available for a fee
from the Click-N-Run (CNR) software repository. With Linspire’s
recent Freespire announcement, it will include many of the
codecs in the open-source version and make the rest available
through CNR. Linspire can include some of the proprietary
codecs, because it has officially licensed the use of the 
algorithms and can therefore ship the codecs. Many other
distributions do not have the resources to license the codecs
so they do not include them.

According to Linspire representatives, in recent conversations
with leaders of other free distributions, many other distributions
are struggling with a way to better address this problem. At
least in the meantime, Linspire and Freespire offer a valid,
completely risk-free, alternative. Let’s hope all of the other distri-
butions discover a way to ship codecs that present no risks to
users. When that happens, everyone sitting on the fence waiting

for this issue to resolve will be able to complete their transition
to Linux and not sacrifice the freedom to enjoy using their
computer to view and listen to everything they desire.�

Kevin Shockey is Editor in Chief of TUX.

P2P

7www.tuxmagazine.com

http://www.tuxmagazine.com
http://shoprcubed.com


P2P

8www.tuxmagazine.com

We’re Everywhere! Praise 
from a Log Cabin in Alaska
I find it a little disturbing that so many
people think “I just want it to work”
means “work just like Windows”. I don’t
want it to work “like Windows”; for the
most part, things in Linux work better,
but there are exceptions.

It is a problem when upgrading Flash or
installing a plugin requires reading several
pages and a download or two, with
installation at the command line as root,
and then having to do it over two or
three times to learn the commands
required to get it all done, and still find it
is “not working”. I do the work because I
want to learn the details inside the sys-
tem, but it slows my ability to shift to
Linux as my primary or only OS.

It is probably the greatest strength and
weakness at the same time. In Linux, it is
possible to get right into anything and every-
thing to make things work my way. The bad
news is that sometimes I have to get in very
deep to get something working when I
would really rather be doing something else.

Keep up the good work. I love TUX for

the information and great presentation.
The landscape, full-screen layout is fantas-
tic! I hope that Mango never changes.
Her attitude is backed up with solid
technical information.

I have read every issue from cover to
cover and am going back to re-read
them all again.
--
michael, in a small cabin in Alaska

A Linux Newbie Requests a
Review of Gentoo Live CD
I am a Linux newbie who figured the best
way to learn is to dive in. I did so with
Gentoo. It has been a major headache
and hassle, as Gentoo is truly the Geek’s
Linux. However, I think a brief review and
discussion of this might be a good idea
for your magazine.

The ultimate Gentoo install is custom-
compiled for your exact piece of hardware
and your exact needs. But you know, if
you do not need that extra nth percentile
of efficiency, you do not really need 
to worry about all of the geeky stuff.
Gentoo, on its live CD, has come out with
an install wizard. They say they did this to

make installation more convenient, not
easier. Although it has its problems, it
actually does make it easier, much easier
to install. A few screens with defaults to
set up time zones, hard drive partitions,
default programs and so on, and you are
ready to go. Don’t install any of the extras
from that wizard is my suggestion, as that
has always caused me problems. This is
the first release of the wizard, so I expect
it will soon improve.

After that, software installation is insanely
easy. Let us say that you want to install
Apache. Go to a text box, and type
emerge apache. Come back in a little
while, and it will have downloaded the
latest production version, compiled it for
your machine, and it is ready to configure
to your needs and rock on. Same thing
with just about any program out there.
As a matter of fact, a single emerge com-
mand will cause it to go out and update
every single program to the latest version,
including the Gentoo system itself.

If it needs other dependent programs or
libraries in order to run, they are automati-
cally installed. If it doesn’t need something
anymore, it will delete it. If someone were

LETTERS
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to write a simple generic templatable edi-
tor for config files, by the next generation
of the wizard, it could be an easy-to-use,
easy-to-install operating system.

Although not quite ready for the average
newbie, it has some great ideas and really
is worth at least a short spotlight article.
--
Phil Smith

I really like the whole concept of live
Linux CDs. It is just a great way to intro-
duce Linux while at the same time, as
with Gentoo, gives the opportunity to
install Linux from the live CD. You are
right, however; Gentoo is not right for
most TUX readers. But, you made me
curious, so we will have to check it out. 
I appreciate your letter bringing this my
attention.—Ed.

An Off and On Linux User
Shares Frustration on Hardware
Compatability with Linux
I have been an off and on Linux user for
several years and read TUX regularly.
Although I agree with users having choice
and so on, I find that the concept of
community support is exaggerated. I
am unable to get sound in my PII 300,
128MB, Creative vibra 128 sound card in
Ubuntu—both Badger and Dapper, and

also FC5. The player shows the sound as
playing, the spectrum analyzer works, but
there’s no sound. This card worked in Red
Hat 9. I find no help in any forum—the
suggestions, if any, are very basic, such as
unmuting the mixer and so forth, but
after that, nobody bothers to help. I have
found several such problems waiting
unanswered. I also find that Firefox is
unable to open certain Web sites. Similar
experience in the forums.

Linux is great, but to be widely accepted
and used, several such problems will have
to addressed. In my humble opinion, the
various distributions should come together
to provide a common installation system
(which may not be all that difficult if egos
are kept aside) and provide drivers even
for less-used hardware. Also it should be
kept in mind that not all Linux users have
an Internet connection.
--
Srinivas Murthy

On the surface level your comments seem
problematic; however, it all depends on
your perspective. I see in your comments
“it just works”-itis. Although I’m sure your
hardware works well for you, it just falls
out of the sweet spot of what Linux sup-
ports. As unfortunate as that sounds, it is
still accurate.

Your hope for one installation system to
rule them all is unfortunately an empty
hope. It will never happen. I tried to
explain in my last editorial that the com-
puter industry has moved on. The diversity
available in free and open-source soft-
ware and the acceptance of what was
once known as normal is gone forever.

Ultimately, you are forgetting one impor-
tant person within your support community.
You. Decisions have consequences. Cause
and effect. You choose to stay with your
existing hardware configuration, that’s
great. That’s your choice, but the expecta-
tion that the community always must rise
to meet your expectations is misguided.
Based on your decisions, it seems the only
way the community will be able to resolve
your issue is for you to join the community
and learn enough until you can get your
sound working. Good support must start
with the owner of that problem. Much
like delegation, you can never delegate
the ultimate responsibility.

Finally, just to put this in perspective,
there was a time when attempting to
install peripherals in Windows was as
problematic as what you are currently
suffering. For some configurations, I bet 
it still happens today. When this happens,
there is no one within the Windows
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community to request help from. I know,
I’ve been there. At least in the Open
Source community, you have the ultimate
last recourse; you can grab a copy of the
source code and try to figure out the
problem yourself.—Ed.

Strong Support for Linux
Application Installation and 
a PHP Tool Recommendation
First of all, I thank you for publishing my
letter in the June 2006, issue. Canonical
has done a great job by deciding to ship
free CDs of Kubuntu 6.06. It would be
really good if support for MP3 playback
had been integrated by default. Anyway,
enabling MP3 has been made easier than
with the previous version.

Regarding the letter in the July 2006 issue
from Mr David Vikstrom requesting sugges-
tions for a  PHP development tool, I think
Bluefish (http://bluefish.openoffice.nl/
index.html) would be a good choice. It
has built-in reference manuals for PHP,
CSS2, HTML and Python. It also supports
several other languages. Vikstrom might
like to give it a try.

I also read the letter from Mr Ken. I
strongly feel that people must change
their ideas about application installation.
Application installation is easy on

Windows, but it is easier on Linux. What
can be easier than simply selecting the
software you want to install and having
your OS download, install and configure
them for you? That is exactly what distri-
butions like Ubuntu, Kubuntu and Mepis
are doing. Of course, longtime Windows
users may find it slightly confusing in the
beginning, but they should feel comfort-
able very soon.
--
Chandru

A TUX Transition Success Story
I just thought I would write to thank you
for the great magazine and support that it
has provided in my transition. I had tried a
couple of distros without much success
during the last couple of years, when I
decided it was time to make a serious
change and go to Linux. So I downloaded
SUSE and went about installing it. It
installed okay, a lot of things did not
work, and I went back to XP. I tried a cou-
ple other distros and was about to give up
when I discovered your magazine. So I sat
down, went through a few back issues
and was determined to give it another go.
Long story short, I am now the happy user
of Ubuntu Dapper 6.06 and have been for
the last month. Kudos to you and all your
crew. You have great magazine that
makes the transition easy. I must say at

this point, I wish I had made the change
earlier; Linux just works.
--
Oliver Higgins

Great letter Oliver—thanks for sharing.
Sniff, sniff, you made my day.—Ed.

An Experienced Linux User
Wants Audible Player and
Networking Tools for Linux
First, let me congratulate you on a great
magazine. I am not by any means a Linux
newbie, but that does not stop me enjoying
your magazine and picking up valuable tips.

I use Linux exclusively at home and have
only my work laptop with Windows XP
Pro, and here was my problem. I will
leave work soon, which will mean good-
bye to Windows. With this in mind, I had
to look at what I used on Windows that I
could not use on Linux. Office—no prob-
lem. I use OpenOffice.org exclusively,
even on my work PC. For e-mail,
Thunderbird is my client of choice on XP
as well, and ditto with the Firefox browser.
In short, I could find only one application
that I used on XP that I could not get for
Linux. This is Audible, which is an audio
book subscription service that I subscribe
to. So, I e-mailed tech support and asked
when the Linux version was going to be
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available. The short answer was not to
hold my breath. What could I do? I love
my audio books, but it was a matter 
of principle. I canceled my subscription.
It’s the only way to make these people 
listen—hit them in the pocket.

I would like to suggest an article on
Smoothwall, the Linux firewall. This
product is a must for all small networks.
An old headless PC, a couple of network
cards and a copy of Smoothwall is all
that’s needed to secure your home 
network. Dedicated firewalls always 
will beat the software versions or the
less-than-ideal firewalls built into ADSL
routers. It is truly worth the effort, and
it’s not so difficult, even for people with
limited network knowledge.
--
Ian Macdonald

The best solution for the Audible
Manager application is to purchase
CrossOver Office and run that application
within Linux. You also could try Wine, if
you would like to avoid the extra costs;
however, if a non-gratis application will
solve your problem, why not take advan-
tage of it? You also could install VMware
player and create a Windows virtual
appliance to run Windows and Audible
Manager within the appliance.—Ed.

A Reader Asks for Advice on
Extending Linux Resources 
to Multiple Computers for
Network and Printer Sharing
I would like to commend you on your
efforts with TUX; I have been a sub-
scriber since your third issue. I like 
your mag so much I have downloaded
and printed out each edition in color
(alright I know better, save the trees,
read the mag on the screen). Sorry, 
but it is such a great read, I can’t help
myself and enjoy reading it without 
the constraints of having to sit at 
my desktop.

I know that I am like many parents in that
one computer is often insufficient when
you have children who constantly want to
use the computer for social networking,
homework and listening to music. Many
homes have two or more computers.
Through my experience, Internet/printer
sharing is straightforward in the Windows
world for most computer users; however,
in the Linux world, in my experience as a
newbie, this is not so. I would very much
appreciate an article(s) on home network-
ing: connecting two or more Linux com-
puters to a DSL modem and connecting
two or more Linux computers to share 
a printer. I did find a great how-to: “Set
up a SUSE 10 Machine as a Router”

(http://www.novell.com/coolsolutions/
feature/16579.html), which was an out-
standing guide for assisting with the
sharing of an Internet connection and
more. Unfortunately, I haven’t found
anything similar for Linux printer sharing,
and I figure why use Samba unless this is
the easiest way.

Further, the Australian government is so
concerned about the proliferation of porn
sites and the potential for children to
access these sites easily that they have
just announced a scheme to reduce the
cost of Internet filtering software signifi-
cantly for home use. I believe an article or
how-to guide called “Internet Filtering for
Linux—Parents Back in Control” would be
a great resource for many.
--
Roger Hawkins

In our May 2006 issue, we covered
Firestarter, an easy-to-use solution for
your Internet-sharing needs. It also
functions as a firewall, as the name might
suggest. As the previous article and your
letter suggest, beating your home net-
work into submission to complete file and
printer sharing can be quite aggravating.
I’ll add a networking issue to next year’s
editorial calendar to address these and
other problems.
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To set up parental filters under
GNU/Linux, you should evaluate and
research the combination of iptables,
DansGuardian and Squid. From the
DansGuardian about page: “It filters
the actual content of pages based on
many methods, including phrase
matching, PICS filtering and URL filter-
ing. It does not filter purely based on 
a banned list of sites like lesser totally
commercial filters.”—Ed.

A Troubled Reader 
Needs Help Using Kino
How about an article on using Kino? I
am trying it out, but I am having a lot
of trouble—capture won’t work and so
on. Googling the problem shows me
that a lot of people are having trouble
with Kino: can’t capture, getting error
messages, not knowing what modules
to load (or remove) and so forth.

TUX magazine is great, and I read 
every issue.
--
Donn

It must be your birthday, because
Donald Emmack provides a beginner’s
look at Kino in this issue (see page 30).
—Ed.

Seeking Help for 
the Little Things
I have used Linux off and on for several
years, but I am not a computer expert.
Maybe you’d call me a fairly literate com-
puter user. Currently, I am using Ubuntu on
two desktop machines, Puppy on a laptop
and IPCop as a firewall and SMEServer. I’m
quite happy with all of this, and my system
works well for me, but I have a tremen-
dously difficult time switching completely
away from Windows. It’s not the big stuff
that makes giving up Windows difficult. It’s
the little things that no one ever seems to
address in print.

I have about 700GB of MP3s saved on
three external USB hard drives. How do 
I get my Linux box to read and play these
files? Is there a simple program out there
that I have been missing, something as
stupidly simple and effective as Windows
Media Player?

I spend a lot of time in Usenet. Is there
anything that is close to being as simple
to install and use as Xnews? So far, all of
the Linux newsreaders I have tried should
have “actively user hostile” appearing
on every screen. Pan is probably my worst
nightmare. I think I have it installed cor-
rectly; it downloads something, but then 
I search and search but can’t find the

downloaded file anywhere.

I realize that you’re probably more set up
to take suggestions from writers about
articles they have prepared than sugges-
tions from users wanting to learn, but
the big programs are so comparable to
Windows that 80% of us will never
notice the difference. It’s the little things
that are the killers.

Thanks for any assistance you may be
able to provide in the future.
--
David Raschen

Although not knowing the details, it sounds
like your problem playing MP3s is not the
player, but it is because you have not added
the appropriate codecs (coder/decoder). The
rub is, however, that the codecs required to
play MP3 files are not openly licensed. They
are proprietary licensed. I dive into this
sticky problem in my editorial. There are
many MP3 capable players; however, unless
you are using Linspire, Freespire or another
distribution that properly licenses these
codecs, you’ll have to obtain the codecs
yourself. For your RSS newsreader woes,
you should check out KNewsTicker and
Akregator and Konqueror—of course, that
assumes you’re using KDE. You are using
KDE, right?—Ed.�
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Maybe I need to look for a new boyfriend. Otaku makes
fun of me because I change what Anime shows I like. I
watch Princess Tutu now. I like the Kinkan-chou town, and 
I think the story is romantic. Maybe Otaku is upset because
I am being more girly. I thought boys liked girly girls.
Maybe he is being more American now and thinks I am
here to play games with him and bring him pizza and beer.
My friend Bunny says I should leave Otaku and marry an
armadillo. I think Bunny needs some medicine to get her 
to stop thinking about armadillos.

I like pizza, but I do not like beer. You think maybe this
is impossible? How can someone who does not like beer
know so much about Linux? Linux and beer are like sushi
and wasabi. You must have both. But I still do not like beer.
I like vanilla drinks and chocolate drinks like Yoo-hoo. I
think Yoo-hoo is my favorite drink. I like jasmine tea too.
Do any of you like tea? Does tea go with Linux? I know 
it cannot go with Linux like beer but maybe it can be a 
second choice.

I drink sake when I read your letters and questions.
Maybe this makes it harder to answer them, but I like sake.
So send more letters, and I will drink more sake. You may
not understand my answers anymore, but I will be very
happy after many letters.

Q Dear Mango, the July 2006 issue of TUX is brilliant; I
particularly liked Kevin Shockey’s article on the differ-

ence between “gratis” and “free” software. At the moment I
am very much in the user camp, unable, as yet, to contribute
to the ideals.

In your introduction you say “I am surprised to get many
questions from people who run Windows and Linux. Why are
you running Windows?” My question, in return, is how do I
replace FoxPro? I need a full relational database. I have tried
OpenOffice.org but cannot seem to achieve anything other than
a flat file let alone “one-to-many” and “many-to-one” relation-
ships. I have gotten some very limited functionality out of
MySQL running from the command prompt, but it seems so
complex to install and set up. I am just trying to install
PostgreSQL, but again it seems very complex to get started.
Is there anywhere I can see working examples beginning
with installing and creating a simple flat file and then 
gradually introducing more sophistication in fairly gentle
steps?—Stephen Hughes, Surrey, England

A Dear Stephen Hughes, there is no reason to be surrey
that you live in England. I hear England is a nice place.

Be happy to live there.
OpenOffice.org 2.0 has a database program that is 

Mango restores old KMail features, gives the bad news about Linux database clients and takes a guess on Fedora wireless networking.
MANGO PARFAIT

Q&A with Mango Parfait
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supposed to be for average users. It can use MySQL and other
databases, but you do not have to run MySQL to use the
OpenOffice.org 2.0 database. It is easier to let OpenOffice.org
use its own databases.

You do not have to make flat files with OpenOffice.org
2.0. You can make bumpy files, pointy files or any other
shape you like. Okay, I am teasing you. But you do not 
have to make flat files. You can use OpenOffice.org to 
make tables and then make forms that use the tables in 
a one-to-many relationship like you say.

I found a sample of an OpenOffice.org one-to-many

database and form on the Web. Figure 1 is a screenshot of
the data entry form.

I chose a sample form because it is too hard to make
one. I think the OpenOffice.org database program has all
the features you will want, but I do not think it is easy to
use these features. Maybe you can learn how to use it. I
know I can learn how to use it, but I do not want to learn
how to use it. I am a genius, but I refuse to use programs
designed to be hard to use. It is not the way computer pro-
grams should work. If programmers are not going to use 
the power of a computer to make the program easy to use,
why do I want to use that program? I can do less work and
save my data on paper.

Kexi is a a much easier-to-use database program for KDE. It
works more like Microsoft Access. I wish I could tell you to use
Kexi. I do not recommend Kexi for now. It can do one-to-many
table forms, but it is a stupid program. You cannot even make
list boxes in your data forms. It also has many bugs. But, the
programmers are making it easy to use. Maybe someday when
Kexi grows up I can recommend it.

Q Why does upgrading a wireless network card cause so
much pain? I am running a Dell laptop with an Intel

Pro/Wireless 2100 internal wireless card. I have installed (and
updated) Fedora Core 5 and have worked through all of the
setup issues (including ntfs), except the wireless. I connect to
two different networks that each require WPA. Isn’t there a
straightforward procedure describing how to find out what 
I have, uninstall the bad parts and install the good? There
seems to be a lot of versioning issues with everything I read,
plus having to go to multiple sites to get drivers/firmware.
Perhaps I have read too much. In the meantime, it is just easier
to hook up the leash and forego the wireless.—Cliff
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A I do not know why Fedora Core 5 does not see your
wireless card. I have the same wireless card in a laptop,

and Ubuntu and Kubuntu see this card and help me install it
when I upgrade.

I think Fedora Core 5 has the driver for this card. You 
can get a driver for this card from other places if you think
maybe the Fedora driver is missing or does not work. Look at
the page http://atrpms.net/install.html to find how to set up
Fedora Core 5 to use ATrpms repositories. I tell you to go 
to this page instead of giving instructions on how to use
ATrpms, because I do not know if you like to use Yum, apt or
other types of installers for Fedora Core. This page tells you

about all of them. Set up your Fedora to use this repository.
If you think you do not have the driver, install the package
ipw2100 now. I hope the installer you like to use knows
which version to get because you need the version that
works with the kernel you are using. I think it is very likely
your installer will get the right package, so do not worry. But
like I said earlier, I think Fedora 5 has this driver and you do
not need to install a new one.

Maybe Fedora does not see that it has a module that matches
your wireless card, so it does not install the module. Maybe
you need to install the module yourself. You can do that as
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the root user with this command:

# modprobe ipw2100

Fedora Core 5 is a wacky distribution. It has the module
you need, but it does not include this card as a choice when
you use the easy network configuration program. Maybe 
the program will see the card anyway if the module is
installed. I do not know. But here is how you can add the
card to the list choices. Log in as root and edit the file
/usr/share/system-config-network/module-info. Find a spot
like this one (it does not really matter, but this is where I put it):

lance
eth
"AT1500, HP J2405A, most NE2100/clone"

Add these lines above so that it looks like this:

ipw2100
eth
"Intel Wireless 2100"

lance
eth
"AT1500, HP J2405A, most NE2100/clone"

Save this file and close the editor.
I will assume you are finished, and the driver is installed

and the module is loaded. Click on the System menu in
GNOME and pick Administration→Networking. It asks you
for a root password so you can do this. You should see a
window like that shown in Figure 2.

I hope you see your wireless card in the devices list. If you
do not see your wireless card, click on the New button. Now
you can define a new wireless card. You can tell Fedora
which card you are using. Pick Intel Wireless 2100 from the
list. Do what is obvious until you get to the window you see
in Figure 3.

Replace the silly stuff I have in my dialog with the stuff
about your wireless card and your wireless network. You see
where there is a place for a key? This is where you put in
your WPA password. Finish the configuration and save it.
Activate the connection from the main window (see Figure 2
and look for the Activate button) or you can reboot. I hope
your wireless card works now.

Q Dear Mango, KMail used to have an entry on a drop-down
menu to Delete Message. It disappeared with SUSE 10.1

and could be found on a pop-up menu from a right-click on the
message or the page carrying the message. I did an on-line
update with the Online Updater, and Delete Message has gone
from there leaving only the Move to trash option.

Even more concerning, there is now no font control on
Composer, or I can’t find it. Configure KMail alters everything else
but not Composer. I like to send my grandkids “HAPPY BIRTHDAY”
e-mail messages in 48 size font, and now I can’t.—Stan

A Hi Stan. I think maybe the people who work on KMail
are trying to make it harder to make mistakes when

they remove the delete option from the menu. You can
make delete easy if you are not afraid of making a mistake.
Put a delete button on the toolbar.

Here is how you do this. Right-click on the KMail toolbar
and select Configure Toolbars... I use KMail as part of
Kontact, so I must select the right toolbar. I select Main
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Toolbar <kmail_part>. See Figure 4 to see what I see. You see
the Delete button in the list on the right? You will see this in
the list on your left. I already moved it to the list on the right.
That makes it appear on the toolbar. You can drag it up and
down on this list to put it where you want it on the toolbar. 
I put it before the Move to Trash icon.

You still can make HTML messages with KMail. [Editor’s
note: by default, mail programs prefer to send mail in

straight ASCII text. To obtain formatting for a message, you
must compose an HTML message, not an ASCII message.]
The HTML composing toolbar does not show up by default
in many versions of Kontact and KMail unless the distribu-
tion changes the configuration. I do not know why this tool-
bar does not show up in default settings. But you can make
it come back easily. Compose a message. Right-click on the
toolbar and select Toolbars→HTML Toolbar. This will make
the HTML composing toolbar show up. Now you can set 48
size fonts like you said. See Figure 5. This is what composing
looks like with the HTML toolbar.�

I am a sweet, humble, delicate and very cute genius who is at your service to
answer your Linux questions. Send your questions to mango@tuxmagazine.com.
I am deeply sorry that I do not have time to respond to anyone directly by
e-mail, but I will select as many questions as I can and answer them here.
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Amarok is a music player for UNIX written using
the KDE libraries. Through the use of various audio
back ends, Amarok supports the playback of a
wide variety of formats. Although it’s part of the
KDE Project, Amarok has an independent release
cycle, which makes for more frequent updates.

The Amarok developers have some fairly radi-
cal ideas about functionality and usability, making
Amarok unlike any other Linux media player. Due
to its unique feature set, it has generated a lot of
media buzz and is becoming very popular among
users of desktops other than KDE.

GETTING STARTED
The first time you run Amarok, you’ll be greeted
with the first run wizard. If you’d prefer not to use
a wizard, you can click Skip, and then configure
Amarok later using its configuration dialog. The
first set of options in the wizard allows you to
configure the Amarok player interface.

Amarok provides two separate interface config-
urations. One combines the player and playlist win-
dows, rather like Rhythmbox or iTunes. The other
configuration separates the interface into a small
player window with a separate playlist that can be
hidden, rather like XMMS or Winamp. If you
change your mind about which configuration you
prefer, you can toggle between them by showing
the playlist if it is hidden and selecting Show/Hide
Player Window from the Settings menu.

The next set of options 
in the wizard allows you to
select folders to be scanned
to add media to your library.
The selection is recursive—
ticking a folder causes all of
its subfolders, and all of
their subfolders and so on,
to be scanned for media.
You probably want this, but
if you’re really sure you
don’t, you can untick the
box scan folders recursively
below the folder list to 
disable this feature.

By default, Amarok also
watches folders for media files
being added or removed and
updates the library accordingly.
If the software you use to rip
CDs creates a playlist file,
Amarok can import these
automatically as well. Scanning and building your
music library can take a few minutes if it’s quite large.
Once Amarok has finished, you are presented with
the player window in the configuration you chose.

Users of other desktops in particular will appre-
ciate the fact that Amarok can be configured to
use multiple audio back ends. Although some KDE
users may want to use aRts, being able to output

to Xine or GStreamer makes a lot more sense for
users of other desktops. This can be configured in
Settings→Configure Amarok→Engine.

THE INTERFACE
The playlist window is the focus of Amarok’s fea-
ture set. On the left are the sidebar browsers, and
on the right is the playlist (Figure 1). Populating

Amarok
With some of the most advanced features of any Linux audio player, Amarok is quickly becoming one of the most preferred available.

JES HALL
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the playlist is as simple as dragging and dropping
tracks or folders of tracks from a file manager
window, or from your collection in the sidebar.

The context browser displays a wide array of
information about the currently playing track. The
Music tab displays metadata about the current
track, and if you have Last.fm support enabled,
suggested tracks from similar artists. The Lyrics tab
automatically downloads lyrics for the currently
playing track. The Artist tab fetches information
about the artist from Wikipedia. Both the lyrics
download and Wikipedia lookup works for radio
streams as well as files played locally.

MANAGING YOUR COLLECTION
After you’ve run the first run wizard, any time you
want to prompt Amarok to scan your collection and
add new media files, you can select Rescan Collection
from the tools menu. You also can add or remove
directories to be scanned by going to Settings→

Configure Amarok, in the Collection section.
The Cover Manager (Tools→Cover Manager) is a

great way to populate your album collection with
cover art quickly. Set your Amazon locale to allow for
differences between albums released in different
countries, and then click Fetch Missing Covers. Be
forewarned; it doesn’t always get them right.
Obscure recordings, and especially those not released
in the US, may not have a cover image available on
Amazon or may be assigned an incorrect image. If
you have your own image file you’d like to use as

cover art, right-click on the album in the cover
manager, and select Set Custom Image. Navigate to
where you’ve stored the image file, and click Open
to load it as the cover image for that album.

Amarok provides a fairly feature-rich tag editor
for editing the metadata in audio files. To edit tags
for one or more files, right-click on selected tracks
in the playlist window or the collection browser,
and select Edit information for <n> tracks. You can
edit an entire album or artist at once by doing the
above on the album or artist name in the collection

HOME PLATE
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browser. When multiple tracks are selected, only
the information they hold in common can be
edited. If you select a group of tracks from the
same album, you would, for example, be able to
edit the Artist, Album, Genre, Year and Comment
fields for all of those tracks at once.

MusicBrainz (http://musicbrainz.org) is a large
community-driven database of music data. Amarok
uses MusicBrainz integration to fill in metadata for
music files automatically. When editing tags for a
single track, as well as being able to edit the other
fields manually, you can click Fill-in Tags Using
MusicBrainz to have the metadata filled in auto-
matically. Amarok will display a list of the matching
tracks. Select the most appropriate one to fill in
the tags. If at any point you want to discard your
changes, click Cancel to leave the file unchanged.

LAST.FM
Last.fm is a service that tracks what music you listen
to and uses this information to match you with peo-
ple who have similar musical tastes. It uses this infor-
mation to suggest other artists you might enjoy
and creates a personalized radio station with these
suggestions. To create an account, visit http://last.fm.

Your music profile is populated automatically
from information uploaded by a compatible media
player. Amarok ships with Last.fm support, but it’s
disabled by default. To enable it, in the configuration
dialog (Settings→Configure Amarok), navigate to
the Last.fm section. To enable full Last.fm integra-
tion, enter your Last.fm user name and password,
and tick Improve my profile by submitting the tracks
I play. If you would rather not submit this infor-
mation, you can opt to leave that box unchecked
and merely allow Amarok to retrieve similar artists.

With Last.fm support enabled, Amarok will
now display a listing of similar artists in the context

browser, and it will suggest tracks in your 
collection that suit the current playlist. This is 
my favourite Amarok feature—with somewhere
around 60GB of media files, often Amarok sug-
gests artists I didn’t even know I had. Clicking on
a suggested track adds it to the end of the playlist.

Another feature of Last.fm that Amarok supports
is customised radio streams. Last.fm creates an
individualised neighbor radio stream based on the
artists in your profile. To listen to a Last.fm stream
within Amarok, select the stream you want to listen
to from the Engage→Play Last.fm Stream menu. As
well as your personalized neighbor radio, you can
select a genre from Global Tag Radio. These some-
times seem to have slightly fuzzy matching—unless 
I am the only person who is startled to hear Mandy
Moore’s “Candy” in the Indie Rock stream.

LOOK AND FEEL
Amarok lets you do some tweaking of its appear-
ance to customise your experience. Most of the rele-
vant settings are in the Appearance section of the
configuration dialog. Here you can change the fonts
Amarok uses as well as the colour scheme. Amarok,
in recent versions, ships with a custom icon theme—
if you use KDE and would prefer Amarok to blend in
a little more, you can turn off the custom icons here
to set Amarok to use your KDE icon theme.

The context browser’s look is controlled by cus-
tomizable cascading style sheets (CSS). A couple
of fairly plain ones ship with Amarok, and more
can be downloaded from within the Appearance
dialog. To see what styles are available, click
Download Styles. The Get Hot New Stuff Browser
will download and install the themes you select
automatically. If the rather violent pink context
browser in these screenshots isn’t your cup of tea
don’t worry—it’s not the default, and there are

plenty of other styles from which to choose.
Another attractive visual tweak allows you to

customise the on-screen display (OSD). Under OSD
in the configuration dialog, enabling it causes a
nifty little pop-up label to appear on screen with
information about the currently playing track
when the track starts playing. With control over
the font, font sizes, color, placement and length
of time displayed on screen, it can be as flamboyant
or unobtrusive as you like.

PLAYLISTS
As well as allowing you to create and save playlists
manually, Amarok has support for radio streams,
podcasts, and dynamic and smart playlists.

Smart playlists let you quickly populate a playlist
with tracks that match certain criteria. Most of the
smart playlists choose the top 15 tracks in a category,
be it the newest, most played, least played and var-
ious others. One loads the entire collection, another
loads 50 tracks at random. The playlist names are
pretty self explanatory—try them and see!

Dynamic playlists are a little different in that
they update automatically. They’re great for a
party or a long day sitting behind a desk.

Amarok has many other features that haven’t
been covered here. It would take three articles
of this length to cover them all in detail. For
more information, visit http://amarok.kde.org,
check out the Amarok handbook or visit
#amarok on irc.freenode.net.�

Jes Hall is a UNIX systems consultant and
KDE developer from New Zealand. She’s
passionate about helping open-source
software bring life-changing information
and tools to those who would otherwise
not have them.
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kdetv is intended to be a lightweight program
to allow you to watch TV programs on your
Linux-based PC. The first question that comes
to mind is why would you want to watch TV
on your computer? There are multiple answers,
such as if you are short on space or living in a
university dorm room, where you don’t have
space for both a TV and a computer. kdetv can
be a solution if you occasionally need to watch
TV at work, such as happened at one of my
former employers, where the accountants 
were required to watch TV coverage of budget
legislation being introduced into Parliament, so
they would be able to answer client questions
the next day.

I should also clarify what kdetv is and is not.
This program simply lets your computer act like
a TV. If you want a full-blown TiVo clone, where
you can not only watch TV but also record TV
shows on your hard drive, you want a harder-
to-set-up/install program like MythTV (see the
MythTV sidebar).

You will need a TV tuner card that is sup-
ported under Linux. For the kdetv program, a
good choice would be many of the cards based
around the Conexant, formerly Brooktree,
bt8xx or Phillips SAA71xx series of chips. There
are a number of things going for these cards,
at less than $40 US, they are inexpensive,
largely well supported under Linux and avail-
able from a number of manufactures. On the

down side, these cards do demand a fair bit 
of CPU resources, and you must pay attention
to the list of supported cards, as a few firms
offer bt8xx/SAA71xx cards that are not sup-
ported under Linux. Also, many of these cards
handle audio simply by having an audio-out
jack on the back of the card, so you need to
plug a little jumper cable between the TV card
and the computer’s audio-in connector. For the
bottom line, double-check a Web site such as
http://linuxtv.org and, in particular, in their
video for Linux (V4L) area for a list of TV tuner
cards known to work with Linux before buying.

Also, before you buy a TV tuner card, you
need to know the TV standard for where the
computer will be used. This is especially impor-
tant if you are buying a TV tuner to be used in
a country other than the one where you cur-
rently are located. The standard for the United
States, Canada, Japan and several other
nations it is NTSC, National Television System
Committee. In most of Europe, other than
France, the standard is PAL, Phase Alternating
Line. In France, the system is SECAM,
Sequential Couleur Avec Memoire. Regardless,
you will be asked what sort of standard you
are using during the setup.

Other hardware issues to consider include your
choice of video card; having a 3-D accelerated
video card, such as the ones based on ATI or
NVIDIA chips, is an asset with a program like this.

On the other hand, for this program, going beyond
the low end, inexpensive 3-D cards doesn’t offer
any advantages. As with TV tuner cards, some of
the 3-D cards are much better supported under
Linux than others, and you should pay attention
to the reviews.

Install and connect the TV tuner card as per
the instructions included with the card. Now
you can start your computer and get ready to
start kdetv.

You can find information on where to get
and how to install kdetv on the kdetv Web 
site, http://www.kdetv.org. Unfortunately, not
all the information listed on the site is always
accurate. At the time of this writing, the infor-
mation on where and how to install kdetv
under Debian GNU/Linux is incorrect. See the
Installing kdetv from Source sidebar for instruc-
tions for distributions like Debian. For other
distributions, you can find packages on the 
following Web sites:

■ SUSE: http://packman.links2linux.org

■ Slackware: http://www.linuxpackages.net

■ Mandriva: http://www.rpmfind.net

Then, simply follow the instructions that come
with your distribution for installing a package.

When kdetv first starts, it automatically runs

kdetv
Linux and kdetv turn your Linux desktop into a fully capable television, as long as you have the prerequisite hardware.

COLIN MCGREGOR
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the Channel Wizard, which asks a series of
questions needed to configure the program
your location. Should you get something

wrong, move or change from, say, antenna 
to cable TV, you can reconfigure the system
manually by running the Channel Wizard

again. Simply click Channels→
Channel Wizard.

If your TV tuner card, driver
software and available TV sta-
tions support the VBI (vertical
blanking interval), some of the
setup steps are made easier as
the computer will be able to
get some setup information
right from the TV signal auto-
matically. So, if you have VBI as
an option, the Channel Wizard
will ask if you want to use it.

The next screen asks from
where the TV tuner card should
get a signal. For most people, 
the answer will be the television
connector, but you also have the
option of using a composite
video jack or s-video jack if you
want to watch a signal from your
VCR. However, you will need 
special cabling between your
computer and VCR to make this
happen. You also will be asked
what sort of TV signal you’re
dealing with—for the US and
Canada the answer is NTSC.

When you get to the fre-
quency table to scan question,
the tricky part is deciding
between us-cable-hrc vs. 
us-cable. HRC, harmonically
related carriers, is a method
some cable companies use to

improve the picture quality. If you get this
question wrong, you may still get TV pictures,
but they likely will look bad and be in black
and white. If you do make the wrong choice,

HOME PLATE

22www.tuxmagazine.com

Figure 1. The start of the Channel Wizard—in this setup, VBI
with the red dot is not an option, but everything else is fine.

Figure 4. The Computer Checking for Available Channels

Figure 3. Selecting the Frequency Table to Scan

Figure 2. Selecting the Video Source and Type of Video Signal
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simply go back and rerun the Channel Wizard.
For the next step, your computer will go look-

ing to see which channels are available. If a local
channel is off the air for some reason, such as late
night maintenance, you may need to re-run the
Channel Wizard.

At this point, the basics are set and you can
get started.

kdetv can show a TV picture in three ways:
Normal gives you a modest-size TV picture with
a list of available channels down the left side
and other options above the TV picture. TV
Mode provides a small TV image without the
other options displayed. In Full Screen, all you
see on screen is the TV picture. In TV Mode

and Full Screen you can get
a list of available options by
clicking your right mouse
button. Each mode has
advantages, such as with
TV Mode, you can have a
TV image up on your screen
and still be able to work on
an OpenOffice.org docu-
ment. On the other hand,
when using kdetv as a TV
replacement, Full Screen is
a better choice.

Two other settings you
may want to tweak are
screen capture and channel
name. Assuming you didn’t
have VBI to fill in the
details, you can make the
Normal screen display a bit
more information than only
a channel number. If you
want to replace 61 with,

say, “PBS - WNED” or some other more inform-
ative note, simply double right-click on the
channel you want to change, type in what you
want to show on screen, and then press Enter.

Sometimes you may want to capture an image
of what is on screen, say a Web site URL, a recipe
or a mailing address. kdetv lets you capture screen
images and then return to them at your leisure.
But, first kdetv needs to know where you 
want the images to be stored. Click Settings→
Configure kdetv→Video. At this point, you will
have a screen with several options, including
where to store screenshots plus what quality
the screenshots should be. I suggest setting 
up a separate directory only for screenshots. 
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Figure 5. The Configure kdetv main screen—most of the default set-
tings in this area can be left alone.

INSTALLING KDETV FROM SOURCE

If you have a distribution that is directly sup-
ported with accurate information on the
http://www.kdetv.org Web site, go that route;
otherwise, follow the steps below. For people
using Debian or other distributions not support-
ed directly by kdetv, you need to compile the
program from source. To do that, download the
source code from the kdetv site (version 0.8.8
at the time of this writing). Next, make sure
you have the required support files/programs
on your system, which, from a basic Debian
Sarge release, means that from the root screen
you will need to type:

apt-get install libqt3-dev
apt-get install kde-devel
apt-get install x-windows-system-dev

Next, as a regular user type:

bunzip2 kdetv-0.8.8.tar.bz2
tar -xvf kdetv-0.8.8.tar
cd kdetv-0.8.8
./configure
make
su
make install
exit

With this, the install should be done. Along the
way, you will be asked for the root password,
which is fine—supply it when asked. Now you
can start configuring the program.

http://www.kdetv.org
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As for quality, keep in mind that a full-size
NTSC screenshot in PNG format and default
quality will consume about 500k per image,
which may be an issue if you are limited on hard
disk space. Once screenshots are configured,
pressing the letter S saves the image of what is 
on the screen (expect the screen to jitter slightly
after asking for a screenshot).

kdetv can be made to work with an infrared

remote control, thanks to the Linux Infrared
Remote Control program, but that is a somewhat
challenging program. For more details, see
http://www.lirc.org.

kdetv is a great little program. For simply
watching TV on your computer, it offers a fair
number of bells and whistles, works with inex-
pensive hardware and is, at least compared to
MythTV, straightforward to install. If you do

want more options, other more-difficult-to-
setup programs are available.�

Colin McGregor works for a Toronto-
area charity, does consulting on the
side and has served as President of the
Toronto Free-Net. He also is secretary
for and occasional guest speaker at
the Greater Toronto Area Linux User
Group meetings.
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Figure 6. A screenshot image—Jan Wong, a journalist with Toronto’s Globe and Mail newspaper on
the receiving end of an interview.

MYTHTV

If you want all the TV viewing tricks, without the
limitations, that a TiVo offers, such as being able
to pause live TV, record to hard disk, have on-
screen channel listings and so on, MythTV is a
free, open-source alternative. MythTV is more
demanding in terms of hardware, and the soft-
ware is more of a challenge to set up than
kdetv. Although the inexpensive TV turner cards
that work with kdetv will work with MythTV, the
gold standard for MythTV is the Hauppauge PVR
series of cards. Hard disk space can quickly
become a real issue with MythTV; for example,
regular analog TV can, in a worst-case scenario,
consume about 2GB of storage per hour of TV
stored. If you want to avoid some of the MythTV
problems, such as setting up a MySQL database,
have a look at Knoppmyth, a version of Knoppix
Linux customized for setting up MythTV
(http://www.mysettopbox.tv/knoppmyth.html).
If you want to look further into MythTV, go to the
official MythTV Web site (http://www.mythtv.org)
or see James Turner’s article “A Linux DVR Is
No Myth—It’s MythTV!” in the December 2005
issue of Linux Journal.
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In the May 2006 issue of TUX, I covered the basics of newsletter cre-
ation with Scribus. In this follow-up article, I dig deeper into Scribus and
choose a couple topics to explore further. The last article attracted good
publicity for this powerful desktop publishing program (DTP). So, based
on that input, I decided to focus on the most frequent requests: fonts
and PDF creation. Many personal and business users rely on .pdf files for
document exchange. So, with this follow-up article, I take a detailed
look at Scribus’ portable document format (PDF) generation and ways 
to add fancy fonts to your publications. Choosing features to cover was
a tough job, because Scribus has so many features. Fortunately, TUX
readers sent in responses to suggest more topics for Scribus.

Scribus is an example of an application that should be widely accept-
ed regardless of licensing. It is available not only for Linux, but Windows
and Mac OS X as well, so availability should not be an obstacle. For
open source to flourish, applications like Scribus must get the attention
of existing Microsoft Windows users. In short, they must see open-
source applications as an equivalent—or better—solution for personal
computing. The availability of high-quality applications should drive
users to Linux, as it did when Microsoft Windows first appeared.

THE FIRST FOR LINUX
Let’s step back and review. Scribus fills a unique need in the Linux 
community. Specifically, Scribus is one of the few applications providing
press-ready output for commercial-quality printing. So, both home and
business users count on Scribus DTP resources. Plus, it’s open source,
and the user community is active and helpful. So, shame on you if you
haven’t already installed it! If you’re going to go for it now, please
check out my article in the May 2006 issue of TUX for installation
instructions and the repository locations.

SPICE UP YOUR DOCUMENTS WITH FONTS
Whether you are designing a form-filled .pdf or a .pdf presentation, selecting
the right fonts will make your output shine. Beware—not all fonts are alike,
and some look bad in print material and great on screen. Choosing the
wrong font type for a .pdf form will make it nearly unreadable.

Scribus In-Depth Tutorial
A follow-up look at Scribus with in-depth coverage of portable document creation and fonts.

DONALD EMMACK
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SUITED UP

Figure 1. The Scribus font preview capability is available from the Extras
menu option.
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Most Linux distributions include a healthy set of font packages as well as
instructions for adding more fonts. The Scribus Wiki (http://wiki.scribus.net/
index.php/Installing_additional_fonts) and the Scribus site (http://www.scribus.net/
index.php?name=Web_Links&req=viewlink&cid=3) provide links to many
font sites and detailed instructions for installation.

Manfred Klein at typOasis (http://moorstation.org/typoasis/designers/
klein/index01.htm) is my favorite place to look for fonts. You can sort through
font styles grouped by decorative, historical and text and picture categories.
As with other areas of Linux software, some fonts are designed only for non-
commercial use. So, make sure to select ones suitable for your environment.

Take your time and look through the font sites to get good samples for your

intended projects. After downloading, type mkdir .fonts in your home direc-
tory. The . in front of fonts tells Linux this is a hidden directory. Thus, you might
need to adjust your file browser to display hidden folders. For Konqueror users,
turn on View→Show Hidden Files before proceeding. Now, you should be able
to see the .fonts directory. Afterwards, place the newly downloaded font files
into this directory. Restart Scribus, and these new fonts will be available for use.
To see the new fonts, go to Extras→Font Preview. Figure 1 shows the Fonts
Preview window displaying the Cardo Regular font.

USING STYLE FONTS TO PRESERVE CONSISTENCY
Good-looking publications (like TUX) have unique styles. Scribus’ style
editor is the tool to manage your tailored publishing look. Go to
Edit→Paragraph Styles, and select New. A screen similar to the one
shown in Figure 2 will appear on the screen. Next, I suggest you name
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Figure 2. Use Paragraph Styles to create a unique look for your document.

Figure 3. Use the Story Editor to apply styles to text frames.
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the style by function. For example, create a heading font and call it
page-heading or something similar.

When you have added the styles necessary for your work, it’s simple
to keep documents looking uniform. While working with a Text Frame,
press Ctrl-Y to open the Story Editor as shown in Figure 3. Next, select
your style design from the paragraph drop-down box and update the
Text Frame.

PDFS
Nearly all computer users are familiar with PDF documents. Portable docu-
ments can lessen form printing costs and dramatically improve readability for
incoming documents. PDFs are platform-independent, and you can use them
on the Web as well. In fancy language, this means a PDF is re-purposed to fit
paper, Internet or presentations with little effort.

Scribus 1.3.3.2 continues to lead the Linux community with PDF creation.
Because Scribus works with PDF versions 1.2-6 and PDF-X and PDF-A, which
one should you use for export? Each version has different improvements, but
the higher version number might not be what you need.

The documentation Web site for Scribus provides an extended discussion
on the differences between each PDF version and how it corresponds with
Adobe Acrobat (http://docs.scribus.net). Most self-print and screen docu-
ments do not include transparency or need exact coloring. So, version 1.3 
is a good choice for general compatibility.

The Scribus team even publishes a Scribus Pre-Press document
(http://docs.scribus.net/index.php?lang=en&page=prepress). You can
give this to your local print shop to explain how well Scribus’ output
works. It clearly explains how Scribus meets commercial standards for
publishing professionals.

WHAT ABOUT PDF READERS?
Nearly all high-profile Linux distributions include some form of PDF 
document reader. Some work fast and do a good job at displaying PDFs.
However, I recommend you download Adobe Acrobat and install the
Firefox plugins.

You will find Adobe Acrobat at http://www.adobe.com. It’s a polished
reader and the industry standard for PDFs. Others, such as Kpdf, will not
work for forms entry.

SAMPLE PDF PROJECT
The Scribus documentation Web site includes a tutorial on creating your
first .pdf file (http://docs.scribus.net/index.php?lang=en&page=examples/
cgiform/pdf_form). Following the steps in this dialog will lead you through
creating a simple PDF document for the Web. Although, nearly the same
steps also apply for a print-based document. This guide explains how to
open and set up the file and placement of boxes and check boxes for data
input. Plus, there is a small section and some sample JavaScript code for
sending the form over the Internet when it’s complete.

Overall, it’s a good tutorial and covers most areas of importance.
However, there are a couple of explanations in the tutorial I want to
describe in more detail. First, after adding a text box to your document,
you need to adjust its properties. This means you need to tell Scribus
what type of data users can enter in the text box. Scribus also lets you
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Figure 4. Accessing the Field Properties to Specify Input Format
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specify the format of the input.
The tutorial says to right-click and select Field Properties. Actually, you

need to select PDF Options→Field Properties to get to the right place. Only 
a small difference, but I’ve seen people become confused and frustrated
looking for Field Properties (Figure 4).

Once you are at the Field Properties, you define whether it’s a text
box, check box or list box, as shown in Figure 5. If you select List Box,
you must build the selection values into the .pdf file. With Text Box
selected, press Ctrl-Y, or right-click and use Edit Text to open the Story
Editor. Scribus saves each paragraph as a selection line for the final PDF.

Once finished with the sample file, you’re ready to export the final version.
To prepare the file for wide use, the Scribus documentation recommends
saving the file as version 1.3 PDF. Go to File→Export→Save As PDF, as

shown in Figures 6 and 7. The tabs at the top of the window show 
several different document features. Review each to make sure your 
settings are correct.

Because we are using a font some computers may not have, it’s good
practice to embed the font in the export process. Figure 8 shows that
I’ve made sure to include the Cardo font under the Fonts tab. When
you’re done, you should have a handsome PDF file with fields properly
formatted for what you need.

FINAL CHECKS
Scribus has a Pre-Flight Verifier to examine your documents and look for
problems before they reach the production line. With PDF files, I also
recommend you put it to one more test. This is especially important for
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Figure 5. Using the File Properties Dialog to Specify the Input Format Figure 6. Export Options Available from Scribus, Including PDF
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large production runs at a third-party print shop.
Scribus documentation and its Wiki suggest several on-line PDF-checking

tools. I use PDF City at http://www.pdfcity.com/index.htm. By using its
pre-flight inspection system, you will gain clues to potential printing
problems before the printer does. PDF City provides this as a free service
and gives any error details in a user-friendly format.

CONCLUSION
Like any other software, it may take editing and publishing a few docu-
ments before you get familiar with the software design. Of course, it is
nice to know that wiki support and in-program help features do an

excellent job of explaining solutions to any problems or questions.
I’m impressed by this program. Being open source, it has room to

grow with continued input and direction from users. The feature set is
robust, and I feel confident recommending it to most small- to medium-
size businesses with average to advanced publishing needs.�

Donald Emmack is Managing Partner of The IntelliGents & Co. He
works extensively as a writer and business consultant in North
America. You can reach him at donald@theintelligents.com or by
cruising the 2 meter amateur RF bands in the Midwest.
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Figure 7. Save as PDF options dialog—remember to review all options carefully. Figure 8. To improve document portability use the Embedding fonts dialog.
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Video editing and capture is a cool ingredient of
any desktop. Microsoft and Apple users have
many tools available to import digital video (DV)
and massage it into nice looking clips. For Linux,
Kino is a DV power tool that keeps pace with the
fast-changing world of multimedia editing.

Learning how to handle your camcorder and
obtain video is usually a straightforward task. It
may not be the best video production, but you
can at least capture events in video media. Like
many other folks, I have a stack of Super8 
and Hi8 video cassettes lining my bookshelf.
Videography skills are not my family’s best talent.
Consequently, no one really wants to sit down
and watch hours of disorganized film clips taken
by a poorly skilled videographer like me.

This is where Kino can rescue you from video-
skill embarrassment. Kino lets you import various
video film clips, edit them to correct mistakes and
add special effects. Digital video capture through
FireWire is Kino’s unique feature.

INSTALLING KINO
I use Kubuntu Dapper Drake for personal and
business needs. However, the repositories don’t
include Kino, so instead of tinkering with Adept, 
I downloaded it from the Kino Web site. [Editor’s
note: other distributions may include Kino on their
distribution media, so install using the distribution
package manager.] If you have the same problem,

download Kino from http://kinodv.org/article/static/1.
Afterwards, unpack the file and follow the
installation instructions contained in the file
labeled INSTALL.

Most digital video cameras use FireWire to
send video output. So, you must use dvgrab to
capture the IEEE 1394 interface and send it to
Kino. As with Kino, dvgrab may not be in your
distribution’s repository. If not, download the file
from http://kinodv.org/article/static/1, and follow
the installation instructions contained in the
compressed file.

Finally, make sure your kernel includes IEEE
1394 capability (http://www.linux1394.org). In
short, this feature allows your computer to control
an IEEE 1394-compliant camcorder through Kino.
It’s possible that your Linux distribution does not
include this automatically. So, use your package
manger to install the following files:

■ libiec61883 (http://www.linux1394.org)

■ libraw1394 (http://www.linux1394.org)

■ libavc1394 (http://sourceforge.net/projects/
libavc1394)

■ libdv (http://libdv.sourceforge.net)

■ libsamplerate (http://www.mega-nerd.com/SRC)

If not found with the package manager, down-
load them from here http://kinodv.org/article/static/1,
and install them by following the installation
instructions included in the compressed file.

Now, you have a full Kino installation, with
the ability to connect to and control many DV
camcorders. Check the compatibility list at
http://www.linux1394.org/hcl.php to make sure
your hardware is compliant before going further.

UNDERSTANDING FILE TYPES
Diving into digital video will expose you to several
video file types. Using the word “several” under-
states how confusing this can be for the novice
video user. To simplify, remember that the most
common compressed files include MPEG-4, .avi
and .asf. You have probably seen many of these
on the Internet. Conversely, raw video or .dv
files have no compression and take up a lot
more storage space.

There are a number of codecs in use. Some
.avi files will not open in Kino because you
don’t have the right codec. For example, you
may not be able to use an .avi file even though
Kino supports this format. Several Internet
blogs mention similar problems. In my tests, 
I occasionally have difficulty opening certain
.avi files in Kino; however, they still play with
my movie player.

A Beginner’s Guide to Kino
Kino is a powerful nonlinear digital video editor for Linux with great support for importing video from MiniDV cameras.

DONALD EMMACK
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FIRST VIDEO EDITING
This brief introduction will get you familiar with
Kino and digital editing. Before you try to use it,
take a look at the documentation on the Kino
Web site (http://kinodv.org/article/archive/9).
Obtaining a grasp of the terminology related to
frames and time values will help you get under-
way with less confusion.

Prepare your kernel by using modprobe to load
the IEEE 1394 features as in Figure 1. Then, run
Kino as the root user. This is important because
some of Kino’s features require root privileges
to work. Once Kino is running, check to make
sure IEEE 1394 is working properly. Go to
Edit→Preferences or press Ctrl-P, and then
select the IEEE 1394 tab. A properly running
installation will have no error messages and the
screen will look like the one shown in Figure 2.

Now the real fun begins. You have two choices:
open an existing video file or capture new raw
video from your camcorder. If you decide to
work with existing files, remember Kino supports
only raw DV and digital video .avi files. For this
article, I focus on capturing new real-time video
from the camcorder.

For demonstration purposes, I used a MiniDV
Canon ZR500. I connected the Canon camcorder
to my laptop computer with a FireWire cable.
After connection, select the Capture tab on the
right side of your screen, and Kino displays the
incoming digital video from the camcorder (Figure 3).

In real-time video capture there is a slight delay,
but it is hardly noticeable.

In this example, I chose to make a video clip
while typing on my laptop keyboard. Use your
mouse to select the Capture button on the bot-
tom of the display screen, and raw video will start
streaming into your laptop hard drive. Once you
have the clip you want, press the on-screen Stop
button, and save your video clip.

It’s important to realize raw digital video files
are very large and need large storage areas. My
keyboard typing video is only seven seconds long,
yet the .dv file is more than 25MB. So, clear some
hard drive space before you offload a significant
amount of video footage from the camcorder.

EFFECTS AND TEXT
Kino does a good job of capturing the raw video
as well as cutting out parts of the clip you don’t
want to keep. The Trim feature in Kino allows you
to cut out parts of the video clip you don’t want.
With the video clip still loaded, select Trim from
the right side of the screen. Now, at the bottom
of the screen, you will see more editing tools
below the clip’s blue time line (Figure 4). The blue
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Figure 2. The Kino IEEE 1394 Preferences screen—
note where error messages would be displayed.

Figure 3. Real-Time Video Capture from a MiniDV
Video Camcorder with Kino

Figure 1. Preparing the Linux kernel to load IEEE
1394 features.

Figure 4. Kino Video Editing Tools and the Video
Time Line (Before Trimming)

Figure 5. Active Video after Trimming the Video
with the Trim Tool
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time line represents the entire length of the clip.
To trim a section, use your mouse to drag the left
and right ends of the blue time line into the time
frame you want. In Figure 5, I have chopped out

the beginning and end of my video clip and kept
frames 70 through 175.

Kino also provides a way to add extra effects
to your video clips. To explore the choices, click
the FX tab on the right of the screen. As shown in
Figure 6, you have the option of adjusting both
audio and video. Because you obviously can’t hear
my audio example, I use my favorite video effect
to show you a cool Kino trick. Use the drop-down
box below Video Filter to select Kaleidoscope.
Then, press the Preview button. As shown in
Figure 7, you’ve now warped the video clip.

After you’re finished editing and adding
effects, rename this new clip in the Output 
section of the FX window. Then, press the
Rendering button to incorporate your new 
clip into a new .dv file.

Although Kino is a DV editor, there are 
several features it does not support. To add
titles and other effects, you may need to 
use Cinelerra (http://heroinewarrior.com/
cinelerra.php3) to achieve your goal. See
http://www.robfisher.net/video for a technical
tutorial on Kino and Cinelerra.

CHEAP HARDWARE CONSIDERATIONS
If you look into low-cost digital video devices,
you’ll find many tapeless camcorders.
Frequently, you can buy these for less than
$100 US. These tapeless camcorders look fun 
to use, because they often have means to 
capture pictures, MP3 playback and other
trendy features. However, camcorders like these
often store the video in a compressed format
like MPEG, .mov or .asf. Once stored in this
manner, you’ll have to convert the file to .avi,
so Kino can read it properly. Plus, such devices
usually do not have a FireWire port.

Solutions to this are complex. My attempts 
to import .avi files not created with Kino work
only part of the time. Konverter is a data conver-
sion package for converting various file types.
Although the most recent release of Konverter
looks promising, it always seems to crash on my
machine. Perhaps we will explore this in a future
TUX tutorial once the application matures.

As a result, I suggest you stay with mainstream
digital video devices. MiniDV is one of the most
popular camcorder formats today for producing
raw video output. MiniDV camcorders store digital
information on a small cassette tape. From a
MiniDV tape, you send the digital video out to a
television, personal computer or other storage
device. Other types of digital video camcorders
store on DVD and hard drives. As long as they
export raw video and are IEEE 1394-compliant
they should work well with Kino.

YOUR TURN TO EDIT
Video editing is just plain fun. Kino makes it
possible for Linux users to take on some home
editing projects, and the application seems poised
to mature with creative new features. Look
through the user correspondence, and you will
find a lively group of people looking to add text
editing and more advanced effects into the next
release candidate. Perhaps you might even work
on the Kino team to make these exciting features
become a reality.�

Donald Emmack is Managing Partner of
The IntelliGents & Co. He works exten-
sively as a writer and business consultant
in North America. You can reach him
at donald@theintelligents.com or by
cruising the 2 meter amateur RF bands
in the Midwest.
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Figure 6. Kino’s Special Effects (FX) Tab for
Modifying Videos with Audio and Video Effects

Figure 7. An Example of the Kaleidoscope Video
Effect

http://www.robfisher.net/video
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Because KPlayer is one of the most widely used
KDE applications, it comes with almost every
KDE-based Linux distribution. If it’s not already
on your system, use a package manager to
install it. If KPlayer is not included with your
distro or you just want to give KPlayer a try,
you can install it via klik (assuming your distri-
bution supports it). Simply launch Konqueror
and enter klik://kplayer, and klik will take
care of the rest. Later, you can move the 
kplayer.cmg file to your home directory and launch
it at any time using the following command:
$HOME/.zAppRun $HOME/kplayer.cmg (where
$HOME is the path to your home directory).

PLAYING LOCAL FILES
If you have media files stored on your hard disk,
you can use KPlayer to play them in several differ-
ent ways. The first and the most obvious way is 
to launch KPlayer and choose File→Open.
Alternatively, you can drag media files into
KPlayer’s main window to play them. You also can
associate media file types with KPLayer using the
File Associations section in the Konqueror configu-
ration dialog. This allows you to play media
files simply by clicking on them. Finally, you
can launch KPLayer from the terminal using the
kplayer filename command, where filename is
the path to the file you want to play.

PLAYING REMOTE FILES
One of the great things about KPlayer is that it
supports KDE’s I/O slaves, tiny modules that allow
you to access files using different protocols. In
practice, this means you can play media files that
are stored on a remote machine as if they were
stored on your local disk. For example, I store all
converted movies on my Linux server downstairs,
and I can play them on my laptop anywhere in
the house. To play a movie stored on a remote
Linux machine, you can use the fish protocol. The
fish protocol is a special protocol for KDE that
requires a running SSH server and Perl installed on
the remote machine. All you have to do is to
enter the path to the file in the Open URL dialog

box in KPlayer. The path should look something
like this: fish:/serveraddress/home/username/
movie.mpeg. Keep in mind though, if you plan to
play high-quality movies stored on a remote machine,
you have to have a pretty fast network connection.

PLAYING DVDS
Loading a DVD film in KPlayer is easy but not as
obvious as it should be. To start a DVD movie, you
have to choose File→OpenURL, and enter the
dvd://1 link, where 1 refers to the track contain-
ing the movie. The problem is that most DVDs
contain multiple titles, and it’s not always obvious
which one contains the movie. You have two
options here: you either can try different combina-
tions and preview the result in KPlayer, or you can
cheat the system by using a tool like DVDShrink
(http://dvdshrink.sourceforge.net). Launch
DVDShrink and press the Set from DVD button
next to the Enter the DVD title to rip field. This
opens the “Titles on this DVD” window containing

KPlayer
When trying to choose a default media player from the wide selection available, KPlayer deserves a close look.

DMITRI POPOV

Figure 1. KPlayer can handle DVDs and a wide
range of media files.

Figure 2. Using KIOslaves, you can play remote
files in KPlayer.

http://dvdshrink.sourceforge.net
http://www.tuxmagazine.com


the list of the available titles. Note the title with
the longest playtime (in Figure 3, it’s Title 2). Tip: 
if KPlayer refuses to play DVDs, check whether the
libdvdcss2 library is installed on your system. This
library handles encrypted DVDs, but not all Linux
distributions have it installed by default.

KPLAYER’S NIFTY FEATURES
Even if you’ve never used KPlayer before, you
quickly can figure out most of its features, and
some of these features can really come in handy.
My favorite KPlayer feature is the ability to use the
mouse to control different settings. For example, if
you place the cursor over the Progress slider, you
can go back and forward using the scroll wheel.
You also can use this trick to control the volume,
contrast and other settings.

If you have a machine that is a bit long in the
tooth, you have two options that can help you
improve the playback quality. From the Player

menu, you can enable either the Soft Frame
Dropping or Hard Frame Dropping features. Both
options drop some frames in order to maintain
smooth playback. As you might have guessed, the
soft option is more gentle than the hard one
(which can, in some cases, break the decoding
process). So you should try the soft frame drop-
ping first, and if that doesn’t work, try hard frame
dropping. You can configure the Frame drop set-
ting either globally (choose Settings→Configure
KPlayer→Advanced) or for each file in the playlist.

Another KPlayer feature worth mentioning is 
its ability to specify separate settings for each file 
in the playlist. When you open a file in KPlayer, 
it’s automatically added to the playlist (choose
Playlist→Show Playlist to show the playlist). To
edit the properties of a file in the playlist, you
need to enable the Playlist Editor first by choosing
Playlist→Show Editor. Left-click on the file you want
and select Properties from the context menu. In the
File Properties window, you can tweak the file’s set-
tings. For example, in the General section, you can

set the file so it always opens in full-screen mode
and change the filename (it could be, for example,
movie title and director). The Video section lets you
change the brightness, contrast, codec, frame rate
and other playback settings. In other words, you
can tailor each file’s settings to your liking.

FINAL WORD
KPlayer is a rather straightforward application, and
this article should help you master not only its
basic functions, but also its more advanced fea-
tures. If you like KPlayer, and you want to get the
most out of it, make sure to check out its official
manual at http://kplayer.sourceforge.net/manual.�

Dmitri Popov is a freelance writer whose
articles have appeared in Russian, British
and Danish computer magazines. His
articles cover open-source software,
Linux, Web applications and other
computer-related topics.
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Figure 3. Use DVDShrink to find the movie track
on the DVD.

Figure 4. The Playlist Editor shows all the files
played in KPlayer.

Figure 5. You can specify separate settings for
each file in the playlist.

http://kplayer.sourceforge.net/manual
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Picasa is an image management and manipula-
tion software package written by Google. Until
very recently, Picasa was available only for
Windows. Google, working with CodeWeavers,
contributors to the Wine Project, has ported
the application to Linux.

When Picasa was released, there was some
skepticism about the use of Wine rather than a
native rewrite of the product for Linux. A major
reason for this skepticism is due to the oft-dubbed
dependency hell that can come about by relying
on other projects. To solve this, Google has pack-
aged Picasa in such a way that it is completely
self-contained and will not interfere or overwrite
any other versions of Wine you may already have
installed. Because it is self-contained, there is no
dependency hell to work through.

I have installed Picasa on a desktop system
with 1GB of memory—an Athlon XP 2500+
processor running Ubuntu 6.06. To begin the
installation process, point your browser to
http://www.google.com/picasa/linux, and click the
Download Picasa For Linux link. From the resulting
page, choose the Free Download (.deb)—for
Debian/Ubuntu x86 option. In Firefox, this pres-
ents you with the opportunity either to Open with
Gdebi or to save the file to disk.

At this time, I would like to take a moment to

reflect on the installation of Picasa. It is often said
that Linux software management is difficult. I am
certain that after you have gone through the
installation of Picasa on Ubuntu, you will begin to
see how far from the truth this really is.

Using the Open With (Gdebi) option from
Firefox, click OK. This launches the package man-
agement software for Ubuntu, as shown in Figure
1. All you need do now is click the Install Package
button. You will be prompted to grant administra-
tive rights to the process about to begin and also
will be required to enter your password.

With the software installed, you now can
launch Picasa by navigating to Applications→
Graphics→Picasa. When Picasa is launched for
the first time, you are prompted to scan either
your entire hard drive or limit the scan to your
Desktop. I recommend selecting the Desktop
option. If you choose another option, you will
see many graphics loaded into Picasa’s album list
that you probably will not want to see there,
such as icons for programs. Figure 2 provides an
illustration of the first launch.

An anomaly I discovered at this point in the
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Picasa Breaks the Google Linux
Embargo, but Just Barely
Google and CodeWeavers team up to deliver Google’s first Linux application by using Wine.

DANIEL MCCARTHY

Figure 1. Installing Picasa Figure 2. Starting Picasa
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Picasa experience was that even though I had
selected the Only scan the Desktop option, Picasa
scanned the entire hard drive. This left a bit of
cleanup after the first launch. This nuisance led to
the first feature I used in Picasa: removing folders
from Picasa’s watch list. To do this, right-click the
folder in question, and select the Remove from
Picasa option. The folder on which you have right-
clicked will be selected in the Folder Manager
window. Rather than removing each folder one by
one, I selected the topmost directory, the System
Root, and chose the Remove From Picasa option.
As you can see in Figure 3, you can scan a folder
once, remove the folder from Picasa or watch the
folder for changes.

Picasa creates a folder in your home directory
with the name Picasa Documents with subfolders
My Music, My Videos and My Pictures. For every
album you create within Picasa, you will see a
subfolder in the PicasaDocuments/My Pictures

folder. By default, Picasa will create a subfolder
Export within the PicasaDocuments/My Pictures
folder when you select an image for export.

This brings me to another slightly annoying
feature. Picasa uses Wine, which, in itself, is not a
problem at all. It becomes an annoyance when
you select an image for export. After exporting an
image, Picasa launches a file browsing window to
the location of the exported image. The annoy-
ance comes in the shape of Picasa launching a
Wine file manager program rather than launching
Nautilus, the GNOME file manager. Again, this is
simply an annoyance rather than a lack of feature
or functionality.

DIGITAL CAMERA RECOGNITION
Picasa automatically detected my Olympus
Camedia C-50 camera when it was plugged in.
At the time of detection, select which images

to import into your Picasa library. I had 122
images on my camera at the time of import, and
it took approximately three and a half minutes 
to import the images—including the time it
took for me to decide to exclude those hideous
portraits of myself.

Once an image has been imported, a variety 
of effects, filters and fine-tuning options are
available. I once wrote a how-to on my Web site
(http://linuxphile.org) on the removal of red eye
using GIMP. I have to say that using Picasa to
remove red eye is 100% more efficient. It took me
close to ten minutes to work with the layers and
filters in The GIMP for a single person image com-
pared to the 30 seconds it took to remove red eye
on three people using Picasa. For an example of
the red eye feature, take a look at Figure 4.

The Collage feature is very interesting,
specifically the multiple exposure collage. Picasa
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Figure 3. Folder Manager

Figure 4. Red Eye Removal

BEFORE AFTER
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lets you select multiple pictures and turn them
into a collage in minutes, using four collage types
(Picture Pile, Picture Grid, Contact Sheet and
Multiple Exposure).

The effects that Picasa offers are hugely useful.
I am graphically challenged, so the click-and-point
features offered by Picasa made me feel some-
what competent. In fact, some of the images I
have taken did not turn out so well. For example,
I was at a Black Rebel Motorcycle Club concert at
a club in Washington DC. The club was very dark.
There were flashing lights and other distractions
for my camera. Taking a picture with the flash on
resulted in a blurry mess. Taking a picture without
the flash on resulted in a very dark image. With
Picasa, I was able to import the darkened image
taken without the camera’s flash and make it
somewhat presentable. To do this, I used the
Tuning tab to add light to the image, and then
added the Black & White effect.

Figure 5 provides an illustration of the numer-
ous effects available in Picasa. When applying
effects, users can undo each of the effects
applied. Notice the album navigation controls at
the top of the page. Rather than going back and
forth between the image library and the manipu-
lation tools, you can make use of the navigation
features. Picasa prompts you when changing
images while in the editing mode.

Google has also incorporated the ability to
order prints directly from within Picasa from a
variety of companies. I ordered a poster of a
picture from one of my nieces from Zazzle. When
I chose the Zazzle option, Picasa automatically
uploaded the image for me, and I was able to go
about making the printing selections immediately.
Unfortunately, I have not yet received the poster,
so I cannot give an informed response on the
quality. Other companies listed such as Walgreens,
LifePics and Ritz let you pick up your prints locally.

Picasa has a time-line feature that
organizes your albums into a date-
sequenced order. When viewing the
time line, you can initiate a slideshow
presentation of the images in any
album by double-clicking the album.
When the slideshow is running, you can
change the time between slides. Take
note of the Make a caption text in Figure
5. Any captions added to an image
appear when viewing the time line. This is
perfect for holiday or vacation photos.

I attempted to make use of the
Create a Screen Saver feature. I found,
after a little digging, the results of this
attempt. A folder was created in
PicasaDocuments/My Pictures/Picasa/
Screensaver. This folder contained copies

of the images and nothing more. The user inter-
face was not very intuitive. I received no messages
informing me of the location of the resulting
screensaver, and no error messages.

I did have better luck with the Create a Movie
feature. I created a movie by selecting multiple
images within the library view and selecting
Create→Movie from the top menu. A dialog gave
me the choice of small (320x240), large (640x480)
or widescreen (960x720). Similar to the time line, 
I also was able to choose the number of seconds
between images. With ten images selected, the
actual rendering of the movie took approximately
one minute. The resulting movie was given the
name of the album to which the images belonged,
and it was placed in the PicasaDocuments/
My Pictures folder. Picasa creates a title for the
movie, giving the date and the album title. The
rendered movie has zoom and motion effects.
These effects give it a true video feeling rather
than a stale slideshow.

As I’ve stated previously, I am extremely
graphically challenged. This goes beyond the mere
inability to color coordinate. Picasa has increased
my self esteem in this regard due to its ease of
use. Picasa is the perfect tool for image manage-
ment on Linux. It goes beyond the Nautilus thumb
viewer and auto-import features of GNOME. It
also gives you a wide variety of easy-to-use filters,
effects and management capabilities. I would
hope that someday Google will write a native
Linux version of Picasa, but until that day, I am
quite content to use this current version.�

Daniel McCarthy works by day as a configuration manager for
Computing Options Company developing software in both
Java and PHP. By night, he works as the system administrator
for http://techguy.org. He is an avid Linux enthusiast and
promoter of open-source software.
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Figure 5. Edit Mode
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Google Earth is one of those applications you
must have—no matter whether you find it useful
or simply want to kill time by cruising the globe.
This is perhaps the main reason so many Linux
users spent hours trying to make the Windows
version of Google Earth run on Linux. Luckily, 
now you don’t have to go through the trials and
tribulations of tweaking Wine to make this great
application work on your Linux machine; Google
has released a native Linux version of this excellent
application. According to Google, the software
has been tested on Ubuntu 5.10, SUSE 10.1,
Fedora Core 5, Debian 3.1 and other popular 
distributions, so it should work right “out of the
box” for most Linux users. The download page
(http://earth.google.com/download-earth.html)
also contains information about minimum and
recommended system requirements, which you
should check carefully before you download and
install Google Earth. Because Google Earth fetches
all the data via the Internet, you also need a rela-
tively fast network connection. For this article,
Google Earth was tested on a low-end Acer
TravelMate 243 laptop with a 2.5MHz Celeron
processor and 512MB of RAM running Kanotix
(http://www.kanotix.com) and using a 2Mb ADSL
connection. Even on this modest setup, Google
Earth performed pretty well.

Installing Google Earth on Linux is a breeze.
Simply download the GoogleEarthLinux.bin file into

your home directory, open the terminal window,
and run the sh GoogleEarthLinux.bin
command. Leave the options in the Google
Earth Setup Window as they are, press the Begin
Install button, and the installer takes care of the
rest. That’s it. There is only one thing that doesn’t
work in the beta 4 release. Although the installer
claims it installs desktop menu entries for
GNOME and KDE, they don’t appear anywhere.
This is a minor quibble though, because you can
launch the application by simply running the
googleearth command.

If you’ve used the earlier version of Google
Earth for Windows, you will notice some major
changes in the application’s interface that are
also present in the current Linux version. The
GUI is now more functional, or contains less
eye-candy—depending on how you look at it.
The navigation panel has been replaced with
on-screen controls that fade away when not
used. This simplifies the way you navigate the
maps and frees more space for the actual
imagery. The most interesting improvement is
that the 3-D buildings are now textured, mean-
ing that they look more like real buildings
and not just gray blocks. These 3-D textured
models can be created using the SketchUp
(http://sketchup.google.com) software, which
probably explains why Google bought @Last
Software to obtain SketchUp, not so long ago.

The Linux version of Google Earth looks
almost identical to its Windows sibling, and
there is only one thing missing when you
launch the application on your Linux machine.
Unlike the Windows version, Google Earth on
Linux doesn’t include a default list of interesting
places like Eiffel Tower, Grand Canyon, Imperial

Palace in Tokyo and so on. Although not the end
of the world, those suggestions are a nice starting
point for people new to Google Earth. Hopefully,

Google Earth Linux
With the latest release of Google Earth, Google
finally adds a Linux version.

DMITRI POPOV

Figure 1. The new version of Google Earth features
several interface tweaks.

Figure 2. Click on a 3-D building marker to view the
thumbnail of the model and the download links.

http://earth.google.com/download-earth.html
http://www.kanotix.com
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the list will be added in the next version of 
the application.

If you’ve never tried Google Earth before,
prepare yourself for a treat. Although it would be
impossible to describe all Google Earth’s features,
here are a couple of examples to whet your
appetite. As previously mentioned, Google Earth
now supports 3-D models created in SketchUp,
and you can use the 3D Warehouse Network Link
to get the most out of this feature. Point your

browser to http://earth.google.com/3d.html and
download the 3D Warehouse Network Link file.
Launch Google Earth, choose File→Open and
select the downloaded file. This enables the 3D
Warehouse feature, and when you visit a place in
Google Earth, you see blue houses that mark the
available 3-D models. Click on the blue house to
open a pop-up window containing a thumbnail 
of the 3-D model, its description and the model
complexity indicator.

Two download links allow you to import the
model into Google Earth and Google SketchUp. If
you choose the former, Google Earth downloads
the model and zooms into it so you can see it
in all its glory.

All data in Google Earth is organized in layers
that can be “turned” on and off. For example, turn

on the Shopping and Services
layer to locate shops, banks,
bookstores and so forth on the
map. Most of these layers pull
data from the “official” sources,
but Google users also can add
their own data via the Google
Earth Community layer. Turn on
this layer, and you see all sorts of
information, including other
users’ placemarks and Webcams.
You also can share your place-
marks with the Google Earth
community. Simply left-click one
of your placemarks on the map
and select Share/Post. This opens
the posting wizard, which guides
you through the submission
process. You also can export
your placemarks as KMZ files
and share them only with

selected Google Earth users. You can even e-mail
the placemarks directly from within Google Earth.

All in all, it’s great to see one of the most inter-
esting applications now available on Linux. Google
deserves praise not only for creating a native Linux
version, but also for going the extra length and
making it easy to install and use. If you have 
a machine capable of running Google Earth,
you ought to give it a try. But be warned; it’s
extremely addictive.�

Dmitri Popov is a freelance writer whose
articles have appeared in Russian, British
and Danish computer magazines. His
articles cover open-source software,
Linux, Web applications and other
computer-related topics.
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Figure 3. With a single click you can download
and view the 3-D model. Here is the Notre Dame
Cathedral in Paris.

Figure 4. The Google Earth Community layer provides a
wealth of additional information.

PRICE: free

RECOMMENDED CONFIGURATION:
� Kernel: 2.6 or later
� RAM: 512MB
� Hard disk: 2GB
� Graphics: 3-D-capable with 32MB of VRAM
� Screen: 1280x1024, 32-bit color
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My first experience with Linux came while attend-
ing school and working as an assistant to a professor
in the business department of the university. One
day he came into the office, plunked down a 486
desktop computer and said, “I want a Web server.
Put Linux on this. Talk to Bob down the hall, he’s
got some floppies.” The floppies from Bob—about
20 in all—contained Slackware Linux.

Slackware Linux could be considered the great
uncle of the Linux distribution world. First released
by Patrick Volkerding while he was a student at
Minnesota State University Moorhead in April 1993,
Slackware is one of the oldest if not the oldest con-
tinuously developed Linux distribution on the planet.
It makes relative newcomers, like Ubuntu, seem like
babies. Slackware also tries to be one of the most
“UNIX-like” Linux distributions (more on this later).

If you have to have all of the latest and great-
est packages, Slackware is not for you. Simplicity,
stability and reliability are more important to the
Slackware developers than having the most up-
do-date bleeding-edge versions of everything. As
evidence of this, the latest version of Slackware
still runs on the 2.4 Linux kernel instead of the
more-popular (and current) 2.6 kernel that most
other distributions use.

Simplicity is evident in that the programs
and packages that come with Slackware are not
extensively customized like you see with other
distributions. KDE, for example, does not ship
with a customized window theme or even

something as benign as a customized desktop
wallpaper. As far as I could see, every package
is shipped as close to “stock” as it can be.

Installing Slackware is not for the faint of
heart. The Slackware installation CD is, technically,
a live CD—but it boots you straight into a 
command-line environment instead of to a graphical
desktop. This can be scary if you are used to
seeing an installer or desktop environment launch

right away when booting a live or installation CD.
Instead of an installer walking you through every
step of preparing your disks and choosing pack-
ages, you are given a command prompt and are
expected to know what to do from there.

Once launched, the installer itself is not as pretty
as you will find with more consumer-oriented Linux
distributions like Fedora, SUSE and Ubuntu. It is a
very functional and capable installer, but that’s it—no

Review of Slackware 10.2
With a slow and steady development pace, Slackware wins the race for simplicity, stability and reliability.

DANIEL BARTHOLOMEW

Figure 1. Yes, it really is a live CD—just not the type you may be used to.
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bells and no whistles, no fun facts or marketing
text—it is an installer, and that is its only job. If you
have installed Linux only using graphical installers,
your first stop should be to the Slackware Installation
Help page at http://www.slackware.com/install.
This will walk you through the steps you need
to install Slackware.

When installing Slackware, you have the
option to choose a custom install or to do a full
“install everything” install. I definitely would
choose to install everything; that way, you don’t
need to worry about a missing package of some
sort or other down the road.

The Slackware distribution comes on four CDs.
The first CD contains the base distribution and sev-
eral lightweight window managers. The second CD
contains KDE and a few optional packages. The
third and fourth CDs have the source code of the
distribution and—unless you are a developer or are
just curious—you safely can ignore both of them.

The first boot after installing Slackware can be a
little disconcerting if you are not ready for it. Instead
of using GDM or KDM and booting into a graphical
login screen, like most mainstream distributions do
these days, Slackware boots you to a text-only login
prompt. After logging in, you still will not see KDE
or any of the other alternative desktops, you will be
on the command line. As long as you specified
which graphical desktop you wanted as part of the
install, issuing the startx command from the
prompt will get you into graphical mode.

The selection of packages follows the
Slackware philosophy of simplicity and stability
above all else. The selection of programs in
KDE—apart from popular applications like
Firefox, Thunderbird and Gaim—are all simply
the programs that come with KDE. One
notable absence is the OpenOffice.org office
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Figure 2. The Slackware installer—pretty, isn’t it?

Figure 3. Go with the full install. You’ll be glad you did.
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suite—KDE’s KOffice is bundled instead.
One thing you will want to do if you decide

that Slackware is the distribution for you is to
get familiar with the command line and the
administrative utilities. All administrative tasks
are done on the command line—from package
management using Slackware’s pkgtool utility
to selecting your preferred desktop environment
using the xwmconfig program.

This reliance on administration via the terminal
is done on purpose. As I said earlier, Slackware
consciously tries to be a very UNIX-like distribution.
As such, it eschews graphical configuration and
administration utilities in favor of the UNIX com-
mand line whenever possible. A good resource
for learning Slackware, apart from the official
documentation at http://www.slackware.com,
is from the Slackware Handbook Project at

http://www.slackersbible.org.
Package management in Slackware is different

from other distributions. In Slackware’s case, it
was not done simply to be different, it was done
because when Slackware arrived on the scene,
package systems like Red Hat’s RPM or Debian’s
apt simply did not exist. Instead of inventing its
own package format, Slackware opted to use
specially created gzipped tar files. These special
.tgz package files are installed using the pkgtool
program, which is, of course, command-line-only.

Although many of Slackware’s unique ways of
doing things can be traced back to it being the
first on the scene, it does try to incorporate
good ideas that came later. An example of this
is slapt-get, which mimics the excellent Debian
style of package management while still using
Slackware’s native package format.

As someone who has used Slackware before, I
was ready for its limitations. I also was very happy
with the speed and stability that comes with the
slow development pace. Everything was rock solid.
If you come at Slackware with the knowledge that
it is what it is and it is not trying to impress anyone
with a long list of hot must-have features, you
will not be disappointed. There truly is something
to be said about the old saying “slow and steady
wins the race”.

Slackware is an excellent distribution. It is very
stable and reliable. It is also not a distribution you
would give to your grandmother. If you want to
use Slackware, you need to take the time to learn
its unique way of doing things.�

Daniel Bartholomew has been using
computers since the early 1980s when
his parents purchased an Apple IIe.
After stints on Mac and Windows
machines, he discovered Linux in 1996
and has been using various distribu-
tions ever since. He lives with his wife

and children in North Carolina.
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Figure 4. Selecting Your Preferred Window Manager Using xwmconfig

Figure 5. Finally, the Slackware KDE Desktop

http://www.slackware.com
http://www.slackersbible.org
http://www.tuxmagazine.com

	COVER
	CONTENTS
	P2P
	From the Publisher: The Truth about Installing Applications Programs
	From the Editor in Chief: Slogging through the Murky Swamp of the Digital Millennium Copyright Act
	Letters
	Q&A with Mango Parfait

	HOME PLATE
	Amarok
	kdetv

	SUITED UP
	Scribus In-Depth Tutorial

	TUX EXPLAINS
	A Beginner's Guide to Kino
	KPlayer

	REVIEWS
	Picasa Breaks the Google Linux Embargo, but Just Barely
	Google Earth Linux
	Slackware 10.2


